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Welcome to Power Chords Debut by Howling Dog Systems!

y
&
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Power Chords Debut is a powerful music composition tool. It combines
the best of a sophisticated drum machine, guitar chord computer, MIDI
sequencer, and more. Its unique, object-oriented approach to music
makes song writing quick and easy. Music objects are represented
graphically so no knowledge of notation or MIDI data is required to
make full use of the program.

Best of all, Power Chords Debut fully supports UltraSound patch
caching and bank switching, so if your UltraSound card has RAM on it,
you can access all its advanced features.

About This Manual

This manual does not cover every aspect of Power Chords Debut.
Instead, it gives a fun (we think) introduction to the program. Full
documentation for Power Chords Debut is available from the Help
menu. Just press F1, or choose Help... from the main menu.

How to Get Started

The best way to learn Power Chords Debut is to run the tutorials and
demos included with the program. This manual contains lots of “Cool
Things You Can Do Right Away” to get you making music instantly.
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Power Chords Debut Basic Concepts

Music Objects

Power Chords songs are made
up of “Music Objects:”
Melodies, Bass Parts, Chords,
Chord Rhythms, Drum Parts,
and Controls
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Power Chords Debut Music Objects

In Power Chords Debut, music is composed of small chunks of various
types. These music “objects” include melodies, bass parts, chords, chord
rhythms, drum parts, and controls.

8 F# Funk Bat

?i'- 3 Echo Tech

F#Maj,11

Rock Fill 5

To write a song in Power Chords Debut:

First, create (or import from another song) the objects that make up
the song using the on-screen instruments, Rhythm Editor, or MIDI
Input. Then drag the music objects into place in the Song window.



Book Topics

Chapter Topics

Chapter 1- Power Chords Debut™

...Basic Concepts, cont‘d.

UltraSound Bonus Software
User’s Guide

Each type of music object has its own palette, or storage area. You can
store objects in palettes until you need them, and you can copy objects
to as many locations in the Song as you like.

Auditioning Any Part

Audition any music object or chord easily by clicking on it with the
right mouse button. Power Chords Debut allows you to exchange
different music objects at will as the song takes shape. Don’t like the
drum fill in bar 12? Try out two or three replacements by right clicking
on them in the Drum Palette—choose one, and just drag it into bar 12.
It's done!

Editing Parts

To edit a chunk of music, you simply drag it to the Rhythm Editor,
make your changes, audition as you go, then drag the item back to its
place in the song.

Palettes

Palettes are “holding places” for parts that you want to keep, but may
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or may not use in the song. They also provide a convenient place from
which to load parts into the song.

Automatically Repeating Parts

Once you place a drum part, bass part, or chord rhythm in a bar in the
song, it repeats automatically until you place a different part of the
same type later in the song.

Pattern-Based Advantages

Most sequencers are track-based—they store music in linear tracks that
run the entire length of the song. Power Chords Debut is pattern-
based: the music consists of a number of patterns that can be easily
swapped in and out of the song. A single pattern can appear more
than once in the song, so you only have to record or enter the same
information once. You can move a pattern into the song with one
mouse movement, and change it just as easily.

Feedback

Power Chords Debut is designed to give you lots of auditory feedback
throughout the songwriting process. The chord on the stringed
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instrument plays when you click the stringed instrument window with
the right mouse button.

The right mouse button will also play any chord or rhythm phrase
displayed on the palettes. Just click the desired item once. (Click on it
again to stop playing.)
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Cool Things You Can Do Right Away! — The Rhythm Editor

To use Power Chords Debut as a Drum Machine:

1. Hide all windows—hold the Shift key and click the main window
button bar located on the left
side of the screen.
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5. Click in the grid to create notes, then click Play to play the part.
UltraSound Bonus Software
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Rhythm Editor Controls

To make a note louder or softer, click on it with the right mouse
button and drag up and down.

Loop the part by clicking the Loop button. While it’'s looping, add or
remove drum notes. Click the Stop button to stop looping.

Click the Resolution Scroll Bar in the Rhythm Editor (the only vertical
scroll bar in the window). As you change the resolution, the number of
grid divisions changes so you can make quarter notes, eighth notes,
eighth note triplets and even smaller notes.

To save your part to the Drum Palette at any time, click the Export
button (bottom right hand corner of the Rhythm Editor).

To play any of the parts in the drum palette, click them with the right
mouse button.

To Make a Melody in Power Chords Debut:

1. Hide all windows—hold the Shift key and click on the main win-
dow button bar.
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2.

Show the Rhythm Editor—click the top button in the button bar at
the left of the screen.

Show the Melody Palette—click the Melody button (blue, with a
staff and notes on it) on the main window button bar.

Switch to editing melodies—click on the Melody button in the
Rhythm Editor. The title bar of the Rhythm Editor changes to
“Rhythm Editor: Melody Untitled.”

Click in the Rhythm Editor grid to create notes.
Play the part—click the Play button.

Click the Resolution Scroll Bar to change the default note sizes.
Add notes of different lengths.

To save your part to the Melody Palette at any time, click the
Export button (bottom right hand corner of the Rhythm Editor).

To play any of the parts in the Melody palette, click them with the
right mouse button.
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Fancy Editing, Changing the Instrument Sound, and More!

To make longer notes in the Rhythm Editor, hold the Shift key, and
click and drag to the right with the mouse.

To change the instrument sound of a melody, click the Options button
(red check mark). This brings up the Edit Rhythm Parameters dialog
where you can change all sorts of things.

Select a new instrument sound from the list by clicking on it. You can
test how a part sounds by clicking in a blank area of the Edit Rhythm
Parameters dialog with the right mouse button. Click OK to save your
changes.

In the Rhythm Editor, move groups of notes by clicking the Highlight
button (it has a curved arrow on it, beneath the loop button). Click
and drag in the grid to encircle the notes you want to move. They turn
red when selected. Once you have made a selection, click inside the
selected area and drag to the new location. This method is handy for
moving a part from one drum to another.

To copy groups of notes, highlight the notes as described above, then
hold the Ctrl key while clicking on the selected notes and dragging.



Book Topics

Chapter Topics

Chapter 1- Power Chords Debut™

Fun With the On-Screen Guitar

There are some really neat things you can do with the on-screen
stringed instrument window, as well. It comes configured as a guitar,
but it can be configured to emulate any stringed instrument such as
banjo, guitar, bass, etc.

UltraSound Bonus Software
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Stringed Instrument Window

Recording From the On-Screen Guitar

1.

Hide all windows—hold the Shift key and click the main window
button bar.

Show the Rhythm Editor—click the top button in the button bar at
the left of the screen.

Switch to editing melodies—click the Melody button in the Rhythm
Editor.

Show the Guitar—click the Guitar button on the main window
button bar.

Click the Rec button on the Rhythm Editor.
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You will hear the metronome click off 1 bar to prepare to record. After
this bar, the beat marker in the Rhythm Editor moves to indicate that
you are recording.

6. Strum the strings, bend strings, play chords with the right mouse
button in the fretboard, or click new notes on the fretboard itself.

All this will be recorded. Now you can change the instrument sound of
the recorded part and play back your melody.

More Fun Guitar Stuff—Including Bending Strings

To strum the strings, click and drag in the lower yellow rectangle
below the fretboard. (The cursor changes to a pick when over the
pluck, strum or bend areas.)

To bend the strings, click and drag in the blue rectangle below the
fretboard. The string will bend up and down in pitch. To bend all the
strings at once, click in the string bend rectangle with the both mouse
buttons and drag back and forth.

To slide chords, click on one of the four direction arrow buttons. The
chord will be shifted in the direction indicated.
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To play Melodies on the fretboard, switch to Melody mode by clicking
the Melody button in the Instrument window (the button with one
note on it). Click or drag in the fretboard to produce sustained tones.

To change the instrument sound the guitar plays (yes, you can play a
fretboard piano, organ, vibes or any of the 125 other sounds?!), click
the Tuning Fork button. Then click any of the buttons marked “P” for
“Patch” to select new instrument sounds.

To use Chord Request, the built in “chord computer,” click the button
with the question mark on it. Now you can dial up all sorts of chords
and hear them played.

Chord Parts
Making Chords on the Guitar

1. Switch to Chord mode—click the Chord button (button with 4
notes on it).

2. Make a chord—<click in the fretboard, or use Chord Request to help
you.
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...The On-Screen Guitar, cont’d.

3. Show the Chord Palette—click the green button in the main
window button bar with a picture of an artist’s palette on it.

4. To save a chord to the palette, click the Export button (large
button with arrow pointing right) once, or click the chord and
drag it to the palette.

5. To add a ”hammer-on* or ”pull-off* to a chord, click the button
below the export button with the grace note on it.

Now notes you click the fretboard will be “grace” notes. Click and
hold the right mouse button in the guitar window to hear them.

UltraSound Bonus Software
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Making a Chord Part in the Song

1. Make chords and store them in the Chord Palette (see above).

2. Show the Song window—click the Song button (second from the
top) in the main window button bar.

3. Drag chords from the Chord Palette to each of the first four bars in
the Song window—click the chords in the palette, hold the mouse
button, and drag them to the bar in the Song window.

4. Now show the Rhythm Editor—click the top button in the main
window button bar.

5. Switch to editing chord rhythms—click the Chord button (see
previous illustration).

The title of the Rhythm Editor should change to read “Rhythm Editor:
Chord Untitled.”

6. Create a chord rhythm—click notes in the grid.

7. Drag the chord rhythm to the first bar of the song—click the
Export button, hold the mouse button down, and drag to the bar
in the song window.

UltraSound Bonus Software
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This is the rhythm that will be used to play the chords you dragged to
the song previously.

8. Click the Play button to play the song.

The chord rhythm is used to play the chords in each bar. You can have
a new chord rhythm any time you want (e.g., one per bar if it suits
you), or you can stick with one or two. The chord rhythm will repeat
until you put a new one in a following bar.

A chord rhythm is a strumming or plucking pattern used to play
chords. A chord rhythm represents the pattern played by the right
hand of a guitarist, plucking or strumming the strings, while the
chords indicate where the left hand of a guitarist would fret the
strings. The Chord Rhythm provides the timing information which
indicates when the strings are to be played.

You can create an entire song by combining chord parts, drum parts,
melodies, and bass parts which you create in the rhythm editor and
store in palettes, or import from other songs.

To edit a rhythm from one of the palettes or from the song, click the
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rhythm below its title and drag it to the Rhythm Editor. The Rhythm
Editor will then switch to the correct type and display the part. Note
that the part of that type that was already in the Rhythm Editor will
be overwritten. The other parts of different types that you were
working on are still there, and you can switch back and forth between
them.

For a more complete overview of the program, please, please, please
run the tutorials!

UltraSound Bonus Software
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Power Chords Debut has full built-in support for your UltraSound card.
Patch caching (loading the needed instrument sounds into the RAM on
your UltraSound card) is automatic.

Power Chords Debut also directly supports one of the most exciting
parts of your UltraSound design—changing to different banks of
sounds. This capability lets you access an unlimited number of sounds
from Power Chords Debut using your UltraSound card.

Patches and UltraSound
Where the Instrument Sounds Come From

When you play MIDI music on your UltraSound from a program such as
Power Chords Debut, the instrument sounds you hear come from
‘patch’ files—files containing digitally recorded samples of various
instruments.

You can have any sound on your UltraSound

Applications like Power Chords Debut command the UltraSound card
to load the needed instrument patches from your hard disk into the
card’s memory. It then plays the patches back at different pitches as
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instructed by the MIDI note commands sent to it. Any sounds that can
be recorded (trumpets, violins, guitars, drums, cymbals, whatever) can
be made into patch files for playback on the UltraSound. These sounds
don’t have to be instruments: they also include speech and sound
effects.

Since the UltraSound gets its patches from your hard disk, you can
replace or add to the sounds available. The UltraSound software also
allows you to organize different patch files into groups, or banks.
Power Chords Debut can specify different banks just by changing one
command to the UltraSound card.

More Sounds For Your UltraSound
Howling Dog Systems UltraSound Power Patch CD-ROM

Your UltraSound, UltraSound Max, UltraSound Plug & Play, or certified
UltraSound-compatible sound card is actually a sophisticated sample
playback synthesizer. The card originally shipped with over 5 mega-
bytes of sampled sounds.

How about launching into the sonic stratosphere with a blistering 40
megabytes of professionally recorded instrument sounds?
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You’ll find over 750 instrument and drum sounds: everything under
the sun, from blistering overdriven guitars and thundering pipe organs
to hundreds of drum sounds of all descriptions, from classic analog
synthesizer collections to sound effects.

The Power Patch CD-ROM adds many times the music power of your
original UltraSound at a fraction of the cost. To make it simple to
turbocharge your UltraSound with sonic power, we include all the
information you need—bank setups so you can quickly switch patch
sets, Power Chords .KIT files, and more.

You can access the preconfigured banks of sounds directly from Power
Chords Debut or Power Chords Pro, right off the CD-ROM!

The Howling Dog Systems UltraSound Power Patch CD-ROM Volume 1
is only $99 US! Order today!

The CD-ROM contains all 10 patch sets listed below...or you can order
diskette-based patch sets “a la carte” ($29.95 each).



Book Topics Chapter 1- Power Chords Debut™

Chapter Topics
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Patch Sets on Diskette

FD-1 Real Instrument UltraSound Patch Set WOFS-1 Wall of Sound 707/808/909 Drum Kit Collection
FD-2 UltraSound Drum Patch Set WOFS-2 UltraSound Dance/Pop Patch Set Collection
FD-3 Super Sound Effects UltraSound Patch Set WOFS-3 Latino Collection

FD-4 UltraSound Analog Synth Patches WOFS-4 Sound Effects 1 Collection

WOFS-5 Techno/Rave Collection
WOFS-6 Super/Dance Loops Collection

Order one or more of these exciting patch sets created by the such
sound pros as Francois Dion of IDMEDIA, and the experts at Wall of
Sound Productions. Because the UltraSound holds its sounds in RAM,
adding a new set of patches is almost like getting a whole new sound
card for a fraction of the cost.

Phone 1-800-267-HOWL and order your Power Patch CD-ROM for only
$99 US* today!

*Please include $5 US for air mail shipping in Canada or the US. Outside Canada and the US, add
$10 US for shipping. For Federal Express overnight shipping in Canada and the US only please
add $15 US.

UltraSound Bonus Software
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UltraSound Options: Bank Switching and More

Power Chords has a special UltraSound Options dialog box available.
To access it from Power Chords Debut, select MIDI... from the Main
Menu, then UltraSound Options....

When you use additional UltraSound patches such as those on the
Power Patch CD-ROM, your IW.INI file is updated with the new banks,
file names, and locations. You can then select which banks to use from
the UltraSound Options dialog.

The UltraSound Options dialog displays the Patch Memory Left on your
card, and lets you set alternate melodic and drum banks.

When you edit the Rhythm Parameters in the Rhythm Editor (by
clicking the red checkmark button), you will find a similar set of list
boxes to select the Drum and Melodic banks.

Getting Instant Bank Info

Both dialogs have an Info... button. Click it to see a list of Melodic and
Drum bank information as listed in the IW.INI file. It also lists any banks
that are defined more than once.
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UltraSound Options Dialog Box
Automatic Fallback to the Default Bank

UltraSound banks do not have to include entries for every patch; a
bank can include as little as one patch. If you select a patch that is not
defined in the current bank, your UltraSound selects the patch from
Bank 0, the default General MIDI bank.

UltraSound Bonus Software
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Experimenting with Songs

Changing Instrument Sounds for Individual Parts

Here’s a fun way to experiment with some of the sample songs pro-
vided with Power Chords Debut.

1. Hide all windows—hold the Shift key and click the main window
button bar.

2. Load a song—select File... then Open from the Power Chords
Debut menu bar. Choose a sample song, for example one of the
demo songs.

3. Double-click on melodies (blue) , or bass parts (purple) to bring up
the Edit Rhythm Parameters dialog box.

4. Change the instrument sound for the part—click the instrument
list.

5. Hear your changes—click on a blank area of the dialog (e.g. just to
the left of the instrument list) with the right mouse button.

You will hear the part played with whichever instrument you choose.

UltraSound Bonus Software
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Reorchestrate, or be a producer! Change the instruments the way you
think they should be! Have a blast!

To Change the Instrument for the Chord Part
...continuing from the previous example:

1. Show the guitar window—click the Guitar button on the button
bar.

2. Click the Tuning button on the guitar window. It has a small tuning
fork on it. This shows the Instrument Tuning dialog.

3. Click one of the buttons marked with a “P”” to access the Instru-
ment Sound Selection dialog. Select a new instrument sound.

4. Click OK, then OK in the Tuning dialog to return to the program.

5. Strum the strings on the guitar, or click with the right mouse
button in the fretboard to hear the guitar played with a new
sound!

6. Play the song to hear how the chord part sounds with its new
instrument.

UltraSound Bonus Software
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To change the instrument sound for a single part in a palette, double-
click on it to bring up the Edit Rhythm Parameters dialog.

Song Window Overview

The Song window provides a bar-by-bar framework for song creation.
You drop the various music elements (chords and rhythm phrases) into
place in the Song window to create a song. You can configure the
display in many ways to show you the information you need to per-
form the current editing task, and edit options are available for
copying, moving, and deleting song elements.

There are “slots” in each bar to hold parts of the various types includ-
ing chords, chord rhythms, drum parts, melodies, bass parts and
control parts.

NOTE: Chord rhythms, bass parts, and drum rhythms automatically
repeat in the Song window, so you do not need to insert a repeating
pattern more than once consecutively. A chord rhythm or drum
pattern, once in the song, repeats until superseded by a different one.
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Song Window Controls

Repeat Highlight Dptliuns
Play Stop Cleaver] Tempo ]| InsertBars

> I Ll wl |I o I}#= ||:

Play. Starts the song playing.

Stop. Stops the song playing.

Cleaver. Sub-divides bars for putting in multiple chords.
Repeat. Click to enter a repeat.

Tempo. Click to enter a tempo change.

Highlight. Click, then click and drag in the bars to highlight bars for copying, deleting, moving,
or to indicate the area to insert blank bars over.

Insert Bars. Inserts bars over highlighted area and shifts existing bars in that area to the right.

Options. Accesses the Song Options dialog to control display, time signature, which items play
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Playing the Song

Click on the Play button to play the song. Your selections in the Song
Options Dialog (accessed via the red checkmark button) determine
which parts you hear when you play the song.

Click the Stop button to stop playing the song.

Playing the song from a particular bar

Double-click a blank part in the bar where you want to start playing.
Playing a single part in the song

Click the right mouse button on a part or chord in the song to hear it
alone.

Playing a single particular bar

Click the right mouse button on a blank part of the bar you want to
hear.

Playing the rest of the song from a particular bar forward
Double-click on a blank part of the bar you wish to start from.
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Importing Parts From Other Power Chords Files

Power Chords Debut can audition and quickly import chords, drum,
melody, bass, control and chord rhythm parts from other Power Chords
Debut and Power Chords Pro files. This facility makes it easy to re-use
parts from other files, build libraries of parts, etc.

To import parts from other Power Chords files, choose Import From
Power Chords File from the File menu. Select the file you want to
import from.

The Select Items to Import dialog box lets you choose parts to audi-
tion and import from either the palettes of the song file you selected
or the song itself.

To audition a part for importing, click on its name with the right
mouse button. Click again with the right mouse button to stop play-
ing. This will sound chords as well. When you audition a part, the
name of the part selected is displayed in the upper left corner of the
dialog box.

To select a part for importing, click on it with the mouse. It will be
highlighted if it is selected for importing.
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To select all parts of one type for importing, click the type label button
above the list of parts of that type. Click on it again to clear the
selections.

To import the marked parts, click the Import button.

Exporting the song to a MIDI file

To export your song as a standard type 1 MIDI file, choose File/Export
to MIDI File from the main menu. Enter a valid filename for the MIDI
file. Your song will be saved to that file.

Standard MIDI files can be used by many other DOS and Windows
music programs, or played using the Windows Media Player.

UltraSound Bonus Software
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Why don’t | get any sound?

Power Chords Debut UltraSound Edition uses the UltraSound MIDI
Synth driver and is pre-configured to use this driver. If you just can’t
get it to work, try all the drivers available from the MIDI Configuration
Dialog (Select MIDI..., then MIDI Configuration... from the main menu
bar).

If you are still not getting any sound, check the following:

1.

2
3
4,
5

Are your sound card and MIDI interface properly installed?

Are your speakers or headphones plugged in properly?

Is the volume turned up on the sound card or mixer program?

Is the proper Windows driver installed—the most current version?

Check sound with another program (e.g.: Media Player). If you can
play a MIDI file with the Media Player, your drivers are okay, and
you have to select the correct output driver in Power Chords
Debut.
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6. Is another program competing for the sound resource?

I have stuck notes (notes that don’t turn off).

To clear stuck notes, choose the Panic Button from the MIDI menu.
This will stop all stuck notes from playing.

| don’t hear all the parts in my song.

Check the Song/Options dialog box play parameters. The song parts
missing may be turned off.

I have sound when auditioning parts, but when | play a
song, parts are missing.

You may be running out of patch memory. We recommend that you
increase the memory on your UltraSound to at least 1 MB: contact
Advanced Gravis for more information on this.

| can’t change the instrument for the chords.

The instrument patch for the chord part of any song is changed in the
Instrument tuning. Click the little tuning fork button on the Instru-
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ment window, and change the patch by clicking on the button marked
llP.11

| put chords in the song, but don’t hear them.

Chords in the song will not play unless accompanied by a Chord
Rhythm. In the Rhythm Editor, switch to editing Chord Rhythms, click
in some notes in the grid, and drag the part to the song.

| created a new bank, but the sounds don’t play, even though they
show in the instrument lists.

Make sure that the patches you specify in your bank are actually at
the location indicated by the PatchDir= statement. In other words,
make sure your PatchDir statement actually indicates where the
patches are to be found.

You can check out your IW.INI file by clicking the More... button in the
UltraSound Options or Edit Rhythm Parameters dialogs. This function
automatically checks for repeated bank numbers.

Make sure you didn’t put patch file names in the IW.INI file with .PAT
extensions. For example, 1=anasyn12 works but 1=anasyn12.pat does
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not.

Make sure that you do not repeat any patch numbers in your bank.
Make sure that you do not have more than one bank with the same
bank number in the IW.INI file. (Click the Info... button to check this—
see above). Make sure that you have not misspelled the names of any
patch files. If you have a mistake in a bank, any entries in the bank
below that one will not load.

| can only store melodies in the top slot.

This is part of the design of Power Chords Debut. You can load songs
that have up to 16 melodies in a bar, but can only store melodies in the
first slot. Power Chords Pro will let you access all the melody slots.

UltraSound Options Dialog

UltraSound Bonus Software

User’s Guide 34



Book Topics

Chapter Topics

Chapter 1- Power Chords Debut™

Upgrading to Power Chords Pro

UltraSound Bonus Software
User’s Guide

35

We hope you're enjoying Power Chords Debut. We packed a lot of
features into this version of our award-winning composition product,
Power Chords. The Pro version has even more features and exciting
capabilities to bring your music to life!

We are pleased to offer a very special price on the full retail version of
Power Chords Pro for Power Chords Debut owners.

Upgrade to the full retail version of Power Chords Pro for
a special price of only $79 US!

Power Chords Pro (list price $199.95 US) is even more powerful than
Debut. Here are some of the added features you can expect:

A Full 16 Melodies per Bar. Access up to a full 16 melody parts per bar
for complete creative freedom!

Power Effects Generate Cool Sounds! Power Chords Pro’s Power
Effects can actually generate realistic-sounding strums (up, down, and
alternating), drum rolls, alternate picking effects, and more. Quantize
effects, humanize parts, arpeggiate, and create random patterns—give
your creativity a boost!
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Standard MIDI File Import Opens Up Thousands of Sources of Drum,
Melody, and Other Parts. This terrific feature gives you access to the
output of dozens of music and sequencer programs, and the literally
thousands of MIDI files available on BBSs. Bring a track at a time into
Power Chords Pro, or just a few bars. Audition every bar and track if
you like. Power Chords Pro automatically creates a consolidated drum
track containing all the drum sounds, making it a snap to import and
use drum parts from MIDI files.

Global Part Editing. Want to change the instrument sound of all bass
parts in a song? Switch the melodies on channel 4 up an octave? Or
make all the drum parts just a bit louder? With Global Editing, you can
accomplish any of these feats from a single set of controls with just a
couple of mouse clicks!

Alter key characteristics of all parts of a type in a single action. Filter
by MIDI channel, etc., to select just the parts you want to change.
Change MIDI channels, alter velocities, or change instrument patches
for up to 128 parts at once.

Unlimited MIDI Access. With the full retail version of Power Chords
Pro, you can use any MIDI input or output device you like.
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Includes a comprehensive, 120-page, spiral-bound manual.

Phone 1-800-267-HOWL and order your Power Chords Pro
Upgrade for only $79 US (plus shipping) today!
Please include $5 US for air mail shipping in Canada or the US. Outside

Canada and the US, add $10 US for shipping. For Federal Express
overnight shipping in Canada and the US only, please add $15 US.
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Sound Forge

Click on green-highlighted Complete documentation and tutorials for Sound Forge are included
text to jump to a related in the program‘s online help. Just double-click the Sound Forge icon to
topic in the book start the program, and go to the Help menu for instructions.

E To return, click the Back
button in the tool bar at the
top of the page..
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Click on a Topic or click on
the arrow at the bottom of
the page to continue reading
through the book.

Throughout this book, you
can click on green-high-
lighted text to jump to a
related topic.

E To return, click the Back
button in the tool bar.
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Click on a Topic or click on Music Made Easy
the arrow at the bottom of

the page to continue reading Online Help
through the book.
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Music Made Easy

Click on green-highlighted Right on your PC! Now anyone with a PC and a sound card can experi-

text to jump to a related ence the creation of music. Cakewalk Express™ is a multi-track MIDI

topic in the book recording studio for Windows. Cakewalk lets you record, edit, and play
back music on your sound card or external MIDI instrument. Cakewalk

IE To return, click the Back Express also lets you insert wave audio files and MCI commands into

button in the tool bar at the your Cakewalk tracks for multimedia sequencing.

top of the page..

Cakewalk Express includes the Virtual Piano™, an on-screen musical
instrument that you play with your mouse or computer keyboard. This
is the easiest way for you to begin creating music with Cakewalk.

0 Remember to complete and return your Cakewalk registration card today, so
you can receive important information about your Cakewalk software!

Your product registration card is included in your UltraSound package.
If your package is missing a registration card, please call us right away.

UltraSound Bonus Software
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Online Help
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At any time while you‘re using Cakewalk, including during the tutori-
als in this manual, you can get context-sensitive help by pressing F1.

If you are unfamiliar with Windows programs’ Help systems, please see
your Microsoft Windows User’s Guide.
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Installation

Chapter Topics

Click on a Topic or click on Checking Your Windows 3.1 Setup
the arrow at the bottom of

the page to continue reading Running Cakewalk Setup

through the book.

The Latest News

Installing a Windows MIDI Driver

Connecting MIDI Equipment

Starting Cakewalk

UltraSound Bonus Software
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Step 1. Check Your Windows® Installation

Before you install Cakewalk, you should make sure that you‘ve cor-
rectly installed Windows 3.1 or Windows 95.

00 Cakewalk does not install or run under Windows 3.0.

Avoid Windows 3.0 Video Drivers. Make sure you have the latest
Windows 3.1 drivers for your video adapter. Most newer 3.1 drivers are
faster, which makes all Windows programs faster. More important,
some 3.0 video drivers may cause problems when used with Windows
3.1.

Use the Control Panel to Remove Drivers. If you have ever added
drivers to or removed them from your system, you have probably used
the Windows Control Panel to do so. Removing drivers by any other
method (such as simply deleting or renaming a .DRV file) can cause
problems. If there is a possibility that you have done this, retrace your
steps and remove the driver the correct way, with the Control Panel.

UltraSound Bonus Software

User’s Guide 7
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Step 2. Run Cakewalk SETUP

Follow the instructions in your UltraSound Quick Start to install
the Cakewalk Express software from the Software CD.

UltraSound Bonus Software
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Step 3. Read the Latest News!

Cakewalk SETUP installs an icon for the README.WRI file. Double-click
this icon to view the Cakewalk README.WRI file. This file contains
important information about changes or additions after the documen-
tation was completed.

UltraSound Bonus Software
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Book Topics Cakewalk Topics Chapter 2 - Installation

Chapter Topics

Step 4. Make Sure the Windows MIDI Driver is Installed

Windows® 95 MIDI
Drivers

If you are running Windows 95,
skip these steps. Simply select
the Multimedia icon in the
Control Panel, click the MIDI tab.
Make sure that MIDI for
UltraSound Plug & Play is the
selected MIDI output. If it is, the
correct MIDI driver should be
installed.

UltraSound Bonus Software
User’s Guide
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Cakewalk uses the Multimedia Extensions in Windows 3.1 to talk to
MIDI interfaces and sound cards. The Multimedia Extensions provide a
way for applications to talk to different kinds of MIDI interfaces and
sound cards through drivers. The correct UltraSound Windows drivers
should have been installed during your UltraSound installation. To
make sure:

1. Double-click the Windows Control Panel.
2. Double-click the Drivers icon.

3. Make sure that the following drivers are listed in the “Installed

Drivers” list:
MIDI Mapper TIMER
{MCI} MIDI Sequencer {MCI} Sound

MIDI for UltraSound Plug & Play

4. If any of the first four drivers are missing, click the Add button,
and select the correct driver from the list.

5. If the UltraSound driver is missing, run the UltraSound Setup
program from your UltraSound software disks.
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Step 5. Connect Your MIDI Equipment

Review this section only if If your keyboard has only two jacks—MIDI IN and OUT:
you are connecting an

external MIDI instrument to c . MIDI
your sound card or MIDI onnecting a |

O_

interface keyboard to a MIDI IN ﬂ IN OUT
: interface or sound Master Keyboard MIDI Intgrfac&
Otherwise, skip to Step 6. card without MIDI or sound car
THRU jack
| I | |
IN OUT IN  OUT
Master Keyboard MIDI Int rfacg
Or souna car
Connecting MIDI | |
I;/(Ialyé)bloar%alnd other IN  THRU If your master
modules to a
- MIDI Module A keyboard now seems
MIDI interface or to double notes (they
sound card without I— sound “thicker” or
a MIDI THRU jack. you can only play half
IN THRU
etc. as many at once) see
MIDI Module B | Troubleshooting.

UltraSound Bonus Software
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...Connecting MIDI Devices, cont'd.

If your keyboard has a MIDI THRU jack:

g [ 1 |
THRU IN OUT IN  OUT
Master Keyboard MIDI Interface
or sound card
Connecting a MIDI
keyboard and other
MIDI modules to a IN THRU
MIDI interface or MIDI Module A
sound card with a
MIDI THRU jack.
m w etc.
MIDI Module B
Here’s a Connect this: To this:
checklist: Master keyboard OUT 0  MIDI interface IN
MIDI interface OUT 0  Master keyboard IN

Master keyboard THRU 0  Another MIDI
module‘s IN

UltraSound Bonus Software
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Step 6. Start Cakewalk

Cakewalk SETUP installs a new Program Manager group.

| To run Cakewalk, double-click the icon.

E" The first time you run Cakewalk, it displays the same dialog box that
the Settings | MIDI Devices command uses. This lets you select which
MIDI In and MIDI Out devices you want Cakewalk to use. Each item in
the list is a driver that you‘ve installed using Windows Control Panel.

e Select MIDI MAPPER for your MIDI Out device. You must choose at
least one MIDI Out device. Click the device name to select it, then
click OK. MIDI Out devices are assigned to Cakewalk port numbers
in the order they are listed.

e Make sure to select the Virtual Piano as a MIDI Input device if you
plan to use it. If you also have a MIDI instrument connected to
your sound card through a MIDI interface, select UltraSound MIDI
In Port as well.

0 Remember that after you add or remove a driver in the Windows Control
Panel, you must restart Windows for the change to take effect.

UltraSound Bonus Software
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Click on a Topic or click on
the arrow at the bottom of
the page to continue reading
through the book.
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Chapter 3

The Virtual Plano

Starting the Virtual Piano

Switching Between Cakewalk Express and the Virtual Piano

The File Menu

The Settings Menu

The Help Menu

Instrument Sounds for the Virtual Piano

Playing the Virtual Piano with your Computer Keys

Playing the Virtual Piano with your Mouse

Fader Controls
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To Start the Virtual Piano

.

Yirtual Piano

UltraSound Bonus Software
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Double-click on the Virtual Piano icon (it‘s located in your Cakewalk
Express program group).

The Virtual Piano is an on-screen musical keyboard. The Virtual Piano
turns your keyboard and mouse into real-time MIDI instruments. The
Virtual Piano itself has no sound capability, but it will play music
through your sound card, your PC speaker, or any external MIDI
instruments you have connected to your system.

= Yirtuad Flano

Foe  Seftings  Help

| |
4L ]

The Virtual Piano will also work with other Windows programs that use
standard Windows MIDI drivers for input.
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During Setup, Cakewalk Express automatically installs the Virtual Piano
and its Windows driver for you.

Using the Virtual Piano with Cakewalk Express

Make sure you have both programs running. If you have not already
selected the Virtual Piano as a MIDI input device in Cakewalk, please
refer to the previous chapter.

UltraSound Bonus Software
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Switching Between Cakewalk Express and the Virtual Piano

To move directly between Cakewalk and the Virtual Piano, press Ctrl-K
from either program. You can also use ALT-TAB to move between
these and other Windows programs you have running.

UltraSound Bonus Software
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The File Menu (Alt-F)

The Virtual Piano’s File menu includes two options:
Activate Cakewalk Ctrl-K

Select this option to move into Cakewalk. Cakewalk must already be

running. The Ctrl-K shortcut keys will toggle you back and forth
between programs.

Exit

Closes down the Virtual Piano.

UltraSound Bonus Software
User’s Guide 18
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Settings Menu (Alt-S)

There are two options in the Settings menu. Check and uncheck these
options to select and deselect them.

Use PC Speaker

The Virtual Piano will play music on your PC speaker as well as on your
sound card or MIDI instrument.

Always on Top

This keeps the Virtual Piano window in the foreground of Microsoft
Windows, even when it’s not activated. This option is useful when you
are moving frequently between Cakewalk and the Virtual Piano. When
this option is unchecked, you can still move quickly between the
programs by pressing the Ctrl-K keys.

UltraSound Bonus Software
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Help Menu (Alt-H or F1)

Select Help | Contents for a list of all Virtual Piano Help topics, or select
Help | Search to search for a particular topic or command.

You can also press F1 from anywhere in the Virtual Piano for context-
sensitive Help.

UltraSound Bonus Software
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Instrument sounds for the Virtual Piano

With Cakewalk running, the Virtual Piano lets you play through the
MIDI channel and patch of the currently selected Cakewalk track. If
you change the patch of that track, the Virtual Piano will play the new
sound. See the Basic Tutorial chapter for more information on this
feature.

UltraSound Bonus Software
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Playing the Virtual Piano with your Computer Keys

Related Topics:

Changing Octaves

Holding Notes

Sustain Pedal

UltraSound Bonus Software
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To play the musical keys with the computer keyboard, use the top two
and bottom two rows of the keyboard. Each pair of rows begins on
the note C. Although you can change the octaves for each pair (as
described below), the computer keys are set to always play the same
musical notes. As you press the computer keys, the corresponding
notes on the Virtual Piano are highlighted with a blue dot.

The note name for the most current note is displayed in the upper left
corner of the Virtual Piano screen. So for example, if you play middle C
on the Virtual Piano keys, the note name C5 is displayed in the upper
left corner.

The upper row of each pair represents the black notes or ’half steps*
on a piano. Notice that some keys on these upper rows are not active,
to correspond with the gaps found between the black keys on a real
piano.

Top pair of
computer
keyboard rows

Qlwle[r|T Y uli lo]lrP | Ih
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...Playing the Virtual Piano with Computer Keys, cont’d.

Bottom pair of
computer
keyboard rows
i L
. Changing the Octave
T

Each pair of computer rows may play a different octave of the musical

B o |

. ‘ keyboard. Click on and drag each octave selector horizontally to match
| | the octave you wish to play.
Click and drag the octave and Adjust top row octave mapping up and down

selectors left or right to change
the octaves up or down on the

Virtual Piano. Holding Notes

Press and hold the SHIFT key to turn on two or more notes at the same
time. The notes remain on as long as you hold the SHIFT key.

A and Adjust bottom row octave mapping up and down

Use the CAPS LOCK key to set the SHIFT state on or off without having
to hold the SHIFT key. Use the SPACEBAR to turn off all notes held by
CAPS LOCK.

UltraSound Bonus Software
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...Playing the Virtual Piano with Computer Keys, cont’d.

Sustain Pedal

Use the CTRL key to send a MIDI sustain pedal message (MIDI control-
ler 64). This is different from actually holding down the notes on the
keyboard. It is like using the sustain pedal of a piano to hold the notes,
even though you have released the keys. Press the CTRL key to push
down the sustain pedal, and release the CTRL key to lift the pedal.

UltraSound Bonus Software
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Playing the Virtual Piano with your Mouse

To play the musical keys with the mouse, point to them and click. You
can use the SHIFT, SPACEBAR, CTRL, and CAPS LOCK keys to hold and
sustain notes with mouse clicks, too.

UltraSound Bonus Software
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Fader Controls

= Tt [ On the left side of the Virtual Piano are three faders: Pitch, Modula-
tion, and Velaocity. Each can be used as you play the Virtual Piano.
] These faders do not work with the PC Speaker option.

O The exact effect of Pitch, Modulation, and Velocity depends on the synthexizer
or sound card you are using. If there doesn‘t seem to be any effect when you
move a slider, it‘s probably because your synthesizer or sound card does not
respond to that MIDI controller.

Pitch Bend Slider

The Pitch Bend slider sends a MIDI pitch bend message. On most
synthesizers and sound cards, this ’bends* the pitch higher or lower.
The Pitch Bend slider snaps back to the center position when you
release it, just like on most professional music keyboards.

ol T
=4 —Dor-mss

|
Le
Zo—-Ar—rCcogo=X

Shortcut Keys: INSERT and DELETE—Increase and decrease pitch bend slider
Modulation Slider

The Modulation slider sends a MIDI modulation wheel message. On
most synthesizers and sound cards, this adds "vibrato* or some other
effect.
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...Fader Controls, cont’d.

Shortcut Keys:

Shortcut Keys:

UltraSound Bonus Software
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HOME and END—Increase and decrease modulation slider

Velocity

The Velocity slider changes the velocity (the striking speed) of the
musical keys you press. On most synthesizers and sound cards, this
makes the notes louder or brighter.

PAGEUP and PAGEDOWN—Increase and decrease velocity slider

Chapter 3 — The Virtual Piano
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Tutorial Startup Checklist

Chapter 4

Basic Tutorial

Cakewalk and General MIDI Instruments

The Screen Layout

Moving Around the Track/Measure View

Selecting Commands
Loading a Song File
Playing

Changing the Tempo
Muting a Track
Looping Tracks
Adjusting Fader Levels
Recording

Saving Your Music
Opening Other Views
Ending a Cakewalk Session

Summary
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Tutorial Startup Checklist

Click on a Topic or click on
the arrow at the bottom of
the page to continue reading
through the book.
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In this chapter, you will go through Cakewalk's basic playing and
recording functions. This section assumes that you have already in-
stalled Cakewalk Express and the Virtual Piano. If you have not already
done so, please read the Installation chapter now.

Before you start this tutorial:

1. Have both Cakewalk Express and the Virtual Piano running. You
can use the ALT-TAB or CTRL-K keys to move between the two
programs.

2. From the Virtual Piano, select Settings | Always on Top.

3. Resize the Virtual Piano window so that you can still see
Cakewalk's Track/Measure view above it. This way you will be able
to move between Cakewalk and the Virtual Piano more easily.

4. From Cakewalk, make sure that you have selected at least one
MIDI Input and Output device for Cakewalk, using the Settings
MIDI Devices command. TTS Virtual Piano In will appear as an
available MIDI Input device. Be sure to select it.
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Cakewalk and General MIDI Instruments

By default, Cakewalk Express uses General MIDI (GM) patch names,
note names, bank numbers, and MIDI controllers. Many of today's
popular sound cards are GM-compatible. If your sound card or MIDI
keyboard is GM-compatible, you are ready to begin loading and
playing MIDI sequences in Cakewalk. If you are not using a GM-
compatible instrument, you need to tell Cakewalk what kind of instru-
ment you have.

See the Settings Menu chapter to learn how to define your MIDI
instrument in Cakewalk using the Settings | Instruments command.

UltraSound Bonus Software
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The Screen Layout

The Cakewalk screen is divided into several sections.
Menu Bar

Along the top line of the screen are the titles of the drop-down
menus. Use these menus to choose commands.

Press F1 while you have a menu command selected to receive Online
Help for that specific command.

Control Bar

Below the Menu bar is the Control bar. This contains various buttons
and information that you need to access frequently.

Message Line

Cakewalk uses the line at the very bottom of the window to display
temporary messages.
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Cakewalk Topics

Moving Around the Track/Measure View
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When you first start Cakewalk, the program displays the Staff view
(bottom half of screen) and the Track/Measure view (top half of
screen).

Now take a look at the Track/Measure view. The left half shows tracks’
parameters. The right half shows tracks' measures.

TrackiMaasure

: -|"I"i I

| = | | =i | o

-]

Moving the highlight

The highlight (the red outline) shows you which is the current track
and column. You can always select a track and column by clicking the
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...Moving Around the Track/Measure View, cont‘d.

mouse, or you can use the four arrow keys—UP, DOWN, RIGHT, and
LEFT—to move around. Try this now. Press DOWN twice; the highlight
moves down two lines.

O These keys are often located on the numeric keypad at the right side of the
keyboard. If the keys are acting as numbers rather than arrow keys, try
pressing the NUMLOCK Kkey.

Notice that whatever line you have the highlight on has its number
drawn in a different color. This means the track is the current track.
The current track is automatically considered selected. Many Cakewalk
commands operate on the selected track. (Most commands can also
operate on more than one track at once; later you‘ll learn how to
select more than one track.)
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Selecting Commands

You tell Cakewalk what you want to do by selecting commands from
the menus.

The Menu bar

If you look at the top line of the Cakewalk screen, you‘ll see a series of
names, like File, Edit, View, Realtime, and so on. Each one is the title of
a menu. When you open one of these menus by clicking its name,
you‘ll see a list of commands. You can open menus and choose com-
mands either by clicking on them, or by using the computer‘s key-
board.

Try opening a menu now. If you want to use keys to open menus and
choose commands, follow these steps:

1. Press and hold down the ALT key.

2. Press the underlined letter in the menu's title: for this example,
press the F key to open the File menu. The File menu drops down
beneath the title.

3. Release both keys.
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...Selecting Commands, cont'd.

Each line of the menu contains the name of a command. Windows
highlights the first command. If you press DOWN, the highlight moves
down through the choices. Pressing UP takes you in the other direc-
tion.

Once the highlight is over the choice you want, press ENTER to choose
it. Do not try this yet; we will try it later in the tutorial. To choose a
command with the mouse, simply click it.

Remember, when the highlight is over a command, you can press F1
(then release the mouse button, if you‘re using it). The F1 key is the
Help key. It opens the Online Help and displays instructions for the
highlighted command.

If you want to get out of the menus, press the ESCAPE key. You can use
ESCAPE in many places in Cakewalk to back out of something if you
change your mind.

4. If you performed the first three steps, try this now. Press ESCAPE
twice, and continue on to the next section.
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Loading a Song File

For this tutorial, we'll load a demonstration song and manipulate it.

1. From Cakewalk's main menu, select the File | Open command to
load a song from a disk file.

Cakewalk displays the Open dialog box. Within the window is a collec-
tion of Cakewalk song files (WRK format). These professionally re-
corded MIDI sequences are useful learning models, and can be used as
frameworks for your original recordings. You can copy sections of a file
and use them in another musical sequence. Or use these files for
”practising* an editing procedure, or to create new arrangements.

O A variety of musical styles are represented in these song files. After you
complete this tutorial, take the time to explore all these files, and be sure to
read the important file information provided in the File | Info pop-up box. Try
viewing different tracks in the Piano Roll, Event List, Staff, and Track/Measure
views, to help you get familiar with Cakewalk and MIDI sequencing.

2. Select bookie.wrk from the list of included song files and click OK.

Cakewalk loads boogie.wrk. The first couple lines of the Track/Measure
view now have names and numbers. The File | Info box will automati-

cally pop up.
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...Loading a Song File, cont‘d.

Take a moment to read through the File Info box for boogie.wrk. It
explains how this sequence was created and arranged, and suggests
ways that you can interact with it. Press ESCAPE or ENTER when you
are finished reading the Info box.

3. Boogie.wrk includes System Exclusive (sysx) data for GS-compatible
instruments. This sysx data is set for Auto Send. Click the OK
button on the pop-up Sysx Auto Send message. (The sysx data has
no effect on non-GS instruments or sound cards. You can also
select Cancel.)

4. Notice that track 1 of boogie.wrk (named ’Play-thru track*) is
preselected in Cakewalk. Track 1 is set up for you to use for the
Recording section of this tutorial.
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Playing

Now that you‘ve loaded boogie.wrk, let's try playing it. First, a quick
checklist:

e To hear music playback, you need to have your MIDI sound source
(your sound card or external MIDI synthesizer) set up and con-
nected as described in the section in Chapter 1 on Connecting MIDI
Devices.

« If you are using an external MIDI synthesizer, set it to receive on
MIDI channels 1, 3, and 10. If you are unsure how to set the MIDI
channel, now would be a good time to check the owner‘s guide.

All set? Let's go!

1. Press the SPACEBAR or click the play button. -

Boogie.wrk will begin playing. In the top-left corner of the Cakewalk
window, you can see some numbers changing. This is the Now marker,
which shows the current count of measures, beats, and ticks (divisions
per quarter note). For instance, ’1:1:0* is measure 1, beat 1, tick 0.

O If you don‘t hear anything, but the Now Marker numbers are advancing, refer
to Troubleshooting.
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...Playing, cont‘d.

2. After letting the song play for a while, press the SPACEBAR or click
the play button again to stop playback.

Note that you use the same key to start and stop playback.

3. If you start playback again, Cakewalk picks up again where you
stopped it.

Y
P

4. Now try clicking the rewind button in the Control bar.

This returns the Now time to the beginning of the song.
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You can speed up or slow down the tempo of a song during playback.
This is useful when you are trying to find a comfortable tempo for
recording.

1. Locate the Tempo Offset controls on the Control bar. They are
located just to the left of the meter/key display.

2. Start playback of boogie.wrk.

3. Position the mouse cursor on the spin arrows next to the Current
Tempo display, and click on the Up and Down arrows to hear the
tempo change.

4. Now click on the three Tempo Ratio buttons located below the
Current Tempo display. By default, these buttons play the music at
.5, 1, and 2 times the speed of the current tempo setting. They give
you a quick way to fast-forward or slow down a playing song file.
You can modify the default Tempo Ratio values by clicking on
them and entering new values.

O There are also ways to control the tempo of a song file graphically. Choose
Tempo View in the Online Help for more information.
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Muting a Track

There are times when you want to hear only one track at a time, or a
specific combination of tracks in a multi-track song. These steps show
you how to mute tracks you don‘t want to hear.

1. Start playback.

2. While the song plays, point to track 2 in the column that has the
checkmark ( ) at the top.

3. Double-click track 2°s

The changes to an m, and Cakewalk mutes the track. What you still
hear is track 3.

4. Double-click the m.
Cakewalk changes the track again, and you can hear it.

O Pressing ENTER also toggles this mute/play switch.
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Looping Tracks

You can have any or all tracks of a song file repeat playback. This is
called looping a track. This can be useful when you wish to play over a
repeating rhythm section, or want a song file to repeat playback
automatically. Tracks can loop up to 9,998 times without stopping
playback. Let's try looping a track.

1. Rewind boogie.wrk to the beginning.

2. Select track 2, and click on the Loop field. Type in the number 2
and hit ENTER. You can also hold down the left mouse button
while in that field and slide the mouse to ”’scroll*“ in a looping
value.

3. Repeat step 2 on track 3.
4. Click the Play button to hear tracks 2 and 3 loop twice completely.

O For more information on looping tracks, refer to Online Help.
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Playing Music in the Staff View

Cakewalk Express automatically displays the Staff view (below the
Track/Measure view) when you load a song file.

The Staff view is where you can see and edit music as standard nota-
tion. You can view up to 24 tracks at a time, with each track assigned
to a separate clef. A track can also be assigned two staves—a treble
and a bass clef. (You would need to scroll down in the window to see
all 24 staves.)

1. Click on the Staff view now to activate it. You can resize the
windows to view all three tracks.

2. Use the horizontal and vertical scroll bars to move through the
Staff view. Start and stop playback. Notice how the notes turn red
as they play back. This can help you keep your place in a perfor-
mance as you listen or play along.

3. Stop playback, and click on the button (in the upper left corner
of the Staff view) to activate audio ”’scurbbing.“ Now drag your
mouse over the notes in the Staff view to hear them audition.
Watch as the notes turn red when you scrub them. Audio scrub-
bing also works like this in the Piano Roll view.
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Adjusting Fader Levels

Cakewalk Express includes a 16-track Faders view. These General MIDI
faders give you real-time control of Volume, Pan, Chorus, and Reverb
levels for tracks 1 through 16. Each fader row also includes a Solo and
Mute button for that track. You can adjust fader levels for playback
only, or you can record your fader movements and save them as part
of your song file.

O Your sound card or MIDI instrument must support Volume, Pan, Chorus, and
Reverb for the Faders to have any audible effect.

1. Rewind boogie.wrk to the beginning.

2. From the main menu, select View | Faders. Three active fader rows
appear in the Faders window from left to right for tracks 1, 2, and
3 respectively (one slider and three knobs per fader row). This is
because tracks 1-3 all have MIDI port and channel assignments,
even though track 1 is currently blank.

3. Click on the Play button to begin playback.

4. Drag the track 2 Volume slider up and down while the song plays.
You should hear the volume change for that track.
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...Adjusting Fader Levels, cont'd.

5. Click and rotate the Pan, Chorus, and Reverb knobs for track 3
during playback.

6. Click the Solo and Mute buttons on and off for tracks 2 and 3.

O If you had the Record box checked, your fader movements would be recorded
into the Cakewalk tracks. The faders would update during playback to reflect
the recorded Controller data. For more information on using faders, see Faders
View in the Online Help.
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Now try recording a track yourself. It doesn‘t have to be an inspired
solo that fits well with boogie.wrk. You can just try making a little
noise! If you want to record a track using the Virtual Piano, see the
following section. If you want to record a track with an external MIDI

keyboard, skip ahead to that section.
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Recording with the Virtual Piano

The Virtual Piano turns your PC's keyboard and mouse into musical
instruments. It's a great way to create music if you have a Windows
sound card but do not have an external MIDI controller or synthesizer.

In order to use the Virtual Piano for this recording exercise, you need
to have both Cakewalk and the Virtual Piano set up as described in
Chapter 1. Please refer to that chapter if you have not already done so.
You can also close the Staff view for now by double-clicking on the
upper left corner of the Staff window.

0 CTRL-K toggles you between Cakewalk and the Virtual Piano.

1. Select track 1 of boogie.wrk (named ’Play-thru track*) by clicking
on the Name field. This track is already set up for you to record on.

2. Click on the Rewind button on the Control bar to get to the
beginning of boogie.wrk.

3. Click on the Record button.
4. You will get a four-beat count-in before recording starts.

5. Before the four-beat count-in is completed, click on the Virtual
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...Recording with the Virtual Piano, cont‘d.

Piano window (or type CTRL-K) to activate it. Any notes you hit
before the count-in completes will be recorded, but are placed at
the time recording actually starts, so it doesn‘t matter if you start
playing a little early.

6. Begin playing the Virtual Piano using your computer keys or
mouse. You can hear the original tracks playing back as you record
your new track. Don‘t be too concerned about sounding good at
this point. The purpose here is to get familiar with the recording
process.

7. When you want to stop recording, click on Cakewalk's Record
button. Now continue to the section in this chapter titled After
Recording a Track.
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First, make sure that Cakewalk routes what you play on the keyboard to
a MIDI channel your synthesizer is set to respond on:

1. Select track 1 of boogie.wrk, named Play-thru track.*
2. Try pressing a key on your synthesizer keyboard.

If you can‘t hear any sound, change the MIDI channel number using the
computer‘s PLUS (+) and MINUS (-) keys while you‘re pressing synthe-
sizer keys. Do this until you hear some sound.

If you don‘t hear sound on any of the 16 MIDI channels, you may not have the
MIDI cables connected properly. Refer to the Connect Your MIDI Equipment
section in Chapter 1.

3. Rewind to the beginning of boogie.wrk.

After the next step, several things happen quickly. You may want to read ahead
up to step 5 before actually starting recording.

4. To start recording, click the Record button in the Control bar.

The metronome starts beeping. There is a four-beat count-in before
recording starts. Any notes you hit now are included, but placed at the



Book Topics Cakewalk Topics Chapter 4 — Basic Tutorial

Chapter Topics

...Recording from a MIDI Keyboard, cont‘d.

time recording actually starts, so it doesn‘t matter if you jump the gun
a bit.

5. Play something on your MIDI instrument. For now, don‘t be too
concerned about what you play. You just want to test out the
recording function.

You can hear the original tracks playing along with you as you record.
Keep recording new material beyond the end of the existing song if
you like.

6. When you want to stop recording, click the Record button
again.

As with playback, the same button turns recording on and off. So does
pressing the computer keyboard's spacebar.

O To discard a recording “take,* use the Undo Recording command in the Edit
menu (Redo works, too). You can toggle between Undo and Redo as many
times as you like.
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After Recording a Track

Notice that the screen is different. The track on which you recorded
has automatically been set to ”playing*“ mode (the mis now a ). Also,
the right half of the Track/Measure view shows that there are events in
the measures of the track—that's what you just recorded.

Now click on the Rewind button, and then the Play button. You should
hear your new track playing along with the original tracks. If you like,
go ahead and record other tracks.

Points and Tips to Remember About Recording

- If you record on a track that already has something on it, Cakewalk
merges or ’blends* the recorded material with the existing mate-
rial.

e You can start recording from any point in a song. You don‘t have
to rewind first, even though we did so in our example.
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Saving Your Music

O If you want to save your newly recorded track on boogie.wrk, you should save
it under a different file name. This way you will always have the original
version of boogie.wrk that you can use again.

It's important to save your work to a disk file. If you don‘t, you lose it
when you exit the program. For the same reason, it‘s good to get in
the habit of saving your work frequently, just in case a power failure
or other disaster should wipe out the work in the computer.

When you load a song from disk, the original still remains on disk, so
you don‘t have to save your song again if you don‘t make any changes
to it. For instance, if you just load a file and play it back without
recording anything new, you don‘t have to save it.

Cakewalk automatically checkt to see if you‘ve changed the song since
you loaded it. If you have, and you try to exit the program without
saving, Cakewalk stops you and gives you a chance to save.

O You can tell whether the file has changed by looking at the file name in the
title of the main window: if there is an asterisk* after the name, the file has
changed.
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...Saving Your Music, cont‘d.

Try saving your changes now.

1. Choose the Save As command from the File menu.
Cakewalk displays the Save As dialog box.

2. Type the file name Boogie2 and click OK or press ENTER.

The pointer changes to an hourglass while Cakewalk writes the file to
disk.

If you had given the original name BOOGIE or the name of any other
file that already exists, Cakewalk would check with you first before
replacing it. If you decide to replace a file, the existing version is
erased and replaed by your new changes. So be sure to click No and
resave the file under a different name if you want to keep the original
version intact.

Cakewalk .WRK Files vs. Standard MIDI Files

When the File | Save As dialog box appears, you will notice a File Type
option in the lower left corner. You can save any file as a Cakewalk
song file (WRK), a Cakewalk template file (.TPL), or as a Standard MIDI
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...Saving Your Music, cont‘d.
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File (.MID). Always save your work as a Cakewalk song file or template
unless you need to use your song with another program that requires
MIDI files. Some Cakewalk information can‘t be stored in MIDI files and
will be lost when you save in that format.
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Opening Other Views

At this point, you may want to begin exploring the other song files
included with Cakewalk Express, and try some of Cakewalk's other
editing views—Ilike the Piano Roll, Controller, Event List, and Tempo
views.

Load any of the included song files and, from the Track/Measure view,
select a track. Then select the View | New command, and choose one
of the listed views. For complete descriptions of these views and their
editing tools, press F1 while in the editing view to get Online Help on
that topic.
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Ending a Cakewalk Session

To quit Cakewalk, select the File | Exit command.
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You now know how to:

e Start Cakewalk Express

e Understand the screen layout

« Navigate the Track/Measure view

e Choose commands

e Load a song file from a disk file

e Change the tempo

e Mute a track

e Loop a track

e Adjust fader levels during playback

e Play and rewind a song

e Record a track using the Virtual Piano
e Record a track using an external MIDI keyboard
e Save asong to a disk file

e End a Cakewalk session.

You can create a lot of music using just this basic set of operations. In
the next chapter, you‘ll learn some basic Cakewalk editing techniques.
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Click on a Topic or click on Overview

the arrow at the bottom of -

the page to continue reading Load Rowrow.wrk
through the book.

The Measure Pane

Make Four Melodies out of the Original

Drag and Drop

Orchestration

Setting the MIDI Channel
Setting the Starting Patch

Other Track Parameters
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The previous tutorial covered the basics of using Cakewalk: loading,
saving, playing, and recording Cakewalk song files.

This chapter introduces you to some of Cakewalk's editing commands.
It assumes that you learned in the previous tutorial how to choose
commands from menus, how to load a file, and how to start and stop
playback. It also assumes that you have your sound card or MIDI
instrument set up as described in Chapter 1.

For this tutorial, we use the theme from Row, Row, Row Your Boat and
create a complete four-part round using Cakewalk's editing com-
mands. This simple exercise teaches you about using some of
Cakewalk's basic editing commands.
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Load Rowrow.wrk

Begin by loading the song file rowrow.wrk. This file contains the four-
measure theme on track one.

Load it now. Click on the Play button or press the SPACEBAR to start
playback, and listen to the theme.
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The Measure Pane

Because it gives you a simplified view of your song, the Measure
pane—the right half of the Track/Measure view—is especially suited
for cutting, copying, and pasting whole measures.

In the upper left-hand corner of the grid, you can see four rounded
dots. This shows you that track 1 has events in the first four measures.
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Make Four Melodies out of the Original

Now add three repetitions of the four-bar theme by using the Copy
and Paste commands.

Mark Track 1

First, mark (or select) the four measures:
1. Point to the first measure.

2. Press and hold the left mouse button.

3. Drag to the right until you get to the fourth measure. Notice that
as you drag, the cells you‘ve dragged over are displayed in reverse,
showing you that you are selecting the measures.

4. When you get to the fourth measure, release the mouse button.

Notice that the From marker on the Control bar is set to 1:01:00. That
is where you started dragging. The Thru marker is set to 4:04:119, the
end of the measure where you stopped dragging.

Use the Copy Command
1. Choose Copy from the Edit menu. Cakewalk displays a dialog box.
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...Make Four Melodies out of the Original, cont‘d.

The default values are just what we want. Notice that the values of the
From and Thru markers are proposed for the From and Thru items of
the dialog box. You will also notice various options you can check.
Leave these options alone for now.

We want to copy events from the one selected track. For this tutorial,
we don‘t need to concern ourselves with using an Event Filter, Tempo
and Meter/Key changes, or Markers.

2. Click OK to accept what is in the dialog box.

The Copy command places a copy of the region you marked into the
scrap buffer.

Paste 3 More Repetitions
Now we want to paste in three additional copies of the theme.
1. Click measure 5 of track 1, the first blank measure.

Notice that the Now time, at the left end of the Control bar, says
5:1:000.

2. Choose Paste from the Edit menu.
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Cakewalk displays the Paste dialog box. Notice that the Now time is
automatically loaded into the To Time item. We want to paste three
more repetitions. So, we want to change the Repetitions item to be 3,
not 1.

3. Type 3, or use the up arrow button to increase the value. The UP
arrow key won‘t do this, but the PLUS (+) key will.

Notice that the dialog box has checked Events - 1 unblank track. It
knows that the scrap buffer contains the events from our Copy. It
hasn‘t checked Tempo changes, Meter/Key changes, or Markers be-
cause we didn‘t copy those.

The default option here is Blend Old and New material. Remember
that a sequencer contains events at various times, and there can be
more than one event at the same time. You may at times want to
“blend” notes, laying one series of events on top of another. The other
options—replacing the old material and sliding over the old material—
can be useful, too. In this example, it doesn’t matter which option we
choose because there is no existing material in the track at measure 5.

4. Click OK.
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The Paste command inserts three repetitions of the scrap buffer into
the song. Notice that now there are sixteen measures in track 1.

Test Drive

At this point, perhaps you want to hear the results. Rewind, then Play.
The theme of Row, Row, Row Your Boat plays four times, for a total of
sixteen measures.
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Drag and Drop: Copying Track 1 to Track 2

Now we want to add another part playing the theme one measure
behind the first track. We can copy all of track 1 to track 2.

Mark Track 1

First, select all sixteen measures of track 1.

1. Click the cell for measure 1, track 1.

2. Drag to the right until you select all sixteen measures.
Drag and Drop

Now we'll learn a faster way to copy and paste measures. You can do
this by dragging and dropping.

You'‘ve selected measures 1 through 16 of track 1. Now do the follow-
ing:
1. Press and hold the CONTROL key.

If you don’t hold down the CONTROL key, you will drag-move instead of drag-
copying. The original won’t be left behind.
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2. Click measure 1, and hold down the mouse button.

The pointer changes to the drag-copy pointer, and Cakewalk displays
Drag a copy of selected measures to new position on the message line.
(You can release the CONTROL key now, if you like).

3. Drag the pointer to track 2, and to the right to measure 2. Remem-
ber to hold down the mouse button while doing this!

4. Release the mouse button.

Cakewalk displays the Drag Copy dialog box. Since you are copying
material to an empty track, the option doesn’t matter.

5. Click OK.

Voila! Now there are sixteen measures of material starting at measure
2 of track 2.

6. Add two more parts, each starting a measure later.
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Orchestration

Most sound cards and MIDI instruments can respond to multiple MIDI
channels simultaneously. Typically, 16 channels are available. This
allows you to hear multiple instrument sounds or patches play back at
the same time. If you have a multi-channel sound card or instrument,
we can practice some simple orchestration.

What we want to do is have Cakewalk send out each track on a sepa-
rate MIDI channel. This lets us set up a separate instrumental sound on
each MIDI channel, which we can do using MIDI patch changes.

Setting the MIDI Channel

The Channel parameter lets you force a track to go out on a particular
MIDI channel.

1. Set each of the four tracks to a different MIDI channel that exists
in your setup. For each track, click its Channel column, type the
number, and press ENTER.
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...Orchestration, cont‘d.

You can also use the PLUS and MINUS keys.

Press: To:
PLUS (+) Add one
MINUS (-) Subtract one

2. Try playing the song again. If a part is missing, you‘ve assigned its
track to a MIDI channel that doesn’t exist in your setup.

Setting the Starting Patch
The Patch parameter lets you specify a starting patch for each track.

O MIDI uses numbers from 0 to 127 to select patches. Cakewalk also lets you
assign a list of patch names to use instead of numbers. When you first install
Cakewalk, it uses the General MIDI list of patch names, which is appropriate
for many sound cards and synthesizers. But you can use the Settings | Instru-
ments command from the main menu to assign other patch name lists.

You can change the Patch parameter by moving the highlight to that
column of a track and using the following keys:
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...Orchestration, cont‘d.

Press: To:

PLUS(+) Add one
MINUS (-) Subtract one
CLOSE BRACKET (]) Add 10
OPEN BRACKET ([) Subtract 10

Other Track Parameters

There are many other parameters besides Patch and Channel in the
Track/Measure view. You can specify a pitch or velocity transposition, a
timing offset, a track name, and more. All of these parameters are
described in the Online Help under Track/Measure View.
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Conclusion

This completes our basic editing tutorial. You should now know how to:

e Select measures in the Measure pane.

e Copy tracks with the Copy command.
 Paste material with the Paste command.
e Drag and drop selected measures.

e Set a MIDI channel for a track using the Chn parameter in the Track
pane.

e Set a starting patch for a track using the Patch parameter in the
Track pane, and associate the Patch number to a patch name list.

You’re well on your way to becoming a skilled Cakewalk user. For more
information on any Cakewalk Express feature, select Help | Contents
from Cakewalk‘s main menu. Or press F1 from anywhere in the pro-
gram to get specific help on your current Cakewalk activity.
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Click on a Topic or click on
the arrow at the bottom of
the page to continue reading
through the book.
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| try to record, but nothing happens
Symptoms

Cakewalk does not record notes from your keyboard.

Causes

The most common mistakes are easy ones to make:

Reversing the MIDI cables.

Not highlighting a MIDI In device in the Input Port(s) part of the
Select MIDI Devices dialog box. If you are only using the Virtual
Piano for MIDI input, make sure you have selected it as a MIDI
Input device.

Installing more than one MIDI interface driver with the Drivers
option of the Windows Control Panel if you have only one in-
stalled MIDI card.

Chapter 6 — Troubleshooting & Technical Support
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...Troubleshooting, cont’d.

Solutions

Check your MIDI cable connections. Make sure to connect the MIDI
Interface or sound card’s jack labeled OUT to the keyboard’s receptacle
marked IN, and the IN jack to the OUT receptacle, as shown in the
illustrations.

e Review your driver setup, as described in Chapter 2, to make sure
that you have selected at least one MIDI In device, and that you
are connecting your cable to the selected device.

| did all that, but still nothing happens
Symptoms

Cakewalk does not seem to record notes from your keyboard, even
though you’ve double-checked your connections and drivers. Or, the
system locks up when Windows starts (in Windows 386 Enhanced
Mode) or when Cakewalk starts (in Windows Standard Mode).
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...Troubleshooting, cont’d.

Causes

This might be due to a conflict over the Interrupt Request (IRQ) that
the sound card or MIDI interface uses to alert the computer when
incoming data arrives. The MIDI interface cannot be set to use the
same IRQ number as some other device in your computer. Examples of
other things that may conflict with the card include:

* A bus mouse. (A bus mouse comes with a card that you insert in an
expansion slot of your computer, in contrast with a serial mouse,
which simply plugs into an existing serial port of the computer.)

< An EGA or VGA card, drawing tablet, scanner, serial printer, CD-
ROM drive, or any other device set to generate interrupts on the
same IRQ as your card, most commonly IRQ 2.

Test

If possible, remove the other device that may be causing the conflict,
such as the bus mouse card. Try running Cakewalk again. If the prob-
lem disappears, you're on the right track.
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...Troubleshooting, cont’d.

Solutions

The solution is to change the IRQ number of either the MIDI interface
or the other device. If you change the IRQ of the MIDI interface, be
sure to run Windows Control Panel, select the driver for the device,
and click Setup. (For UltraSound, choose the UltraSound & MIDI Synth
driver; or use the UltraSound Configuration utility.) In the dialog box,
enter a number to match the new IRQ number you have set on the
MIDI interface. Restart Windows for your change to take effect.

Please consult your sound card or MIDI interface documentation
regarding its default IRQ settings.
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Technical Support

Sooner or later, you will have a question. We are eager to help you get
the most value and satisfaction with Cakewalk music software.

Before you call, please...

« Fax or mail in your registration card today! Only registered Cakewalk
owners can call the Twelve Tone Systems technical support line.

» Refer to Cakewalk’s Online Help system. Press F1 from anywhere in
the program, or select Help | Contents from the main menu.

< Do some experimenting. Try to narrow down your situation to one or
two specific questions or problems.

< Have this manual with you, and try to use a phone near your com-
puter.

= Call our technical support phone line (617-924-6478) Monday
through Friday, 1 PM to 6 PM Eastern Standard Time.

< You can also send us your registration card and receive technical
support via fax (617-924-6657) 24 hours a day.
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...Technical Support, cont'd.

When faxing a technical support question, describe your setup and
problem in detail, and include your name, serial number, and fax
number. We will reply by fax generally within 24 hours during week-
days.

Now on CompuServe

You can reach us on CompusServe; type GO MIDIAVEN* and switch to
our section (number 3). We try to answer questions within 24 hours
during weekdays. There are also a variety of files you can download.
Type ”GO MIDI* for information on general MIDI topics and products.
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Navigating Buttons

To retrace your steps: This guide is designed to make information easy to find. Read it “cover to
|_I_| cover” like a book if you like. Use the navigating buttons or the scroll bar to
page through the guide.

ALd

ﬂ Click the Find button to search for a specific topic.

topage 1 forward EE Click the Bookmarks button to view the complete Contents list.
back 1 page go back

In the Contents (“Bookmarks”) list, click the triangles to view subtop-
forward 1 page  skip to last page ics, and double-click a topic to skip to that page in the guide.

EE Q Click the Thumbnails button to view small previews of each page.

Scroll Bar

Click the up arrow or

Click the Page View button to return to the default view.
drag the slider up to D

|i] 'E'l 'El Click the Resize or Zoom buttons to change the

page view size.

move back.
. Use the Hand tool to move a document page on-screen when it does
Click the down arrow . L X . . .
or drag the slider down gr;, not fit within the window. Drag the hand tool in the direction you

to move forward. want to move the page.

fabei| Use the Text tool to select text to copy.
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